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Chapter
 1
Introduction

This manual supplements the TCP/IP port information contained in the 
NetBackup 6.0 Administrator's guides. In a typical NetBackup environment, 
NetBackup servers and clients use the TCP/IP protocol to communicate with 
each other and with other computers while performing backups and restores. If 
the NetBackup environment is behind a firewall, the default TCP/IP ports used 
by NetBackup might have to be reconfigured to avoid conflicts with firewall 
settings.

Experienced NetBackup and firewall administrators can use the information 
contained in this manual to avoid port usage conflicts as follows:

■ NetBackup administrators cam use this information to reconfigure 
NetBackup port usage, if necessary, to conform to firewall requirements.

■ Firewall administrators can use this information to determine which ports 
NetBackup is using and how they are being used.

General description
NetBackup is a distributed application. The term distributed means that in this 
environment, NetBackup communicates amongst many computers. At the heart 
of this communication is the NetBackup master server. You can configure the 
NetBackup master server to communicate with NetBackup media servers or 
NetBackup media servers and NetBackup clients. These three classes of 
computers are the basic NetBackup computers. There are other classifications of 
computers that also communicate in a NetBackup environment, but their 
method of communication follows the method of communication employed by 
the basic NetBackup computers.

VERITAS NetBackup uses TCP/IP connections to communicate between one or 
more TCP/IP ports. Depending on the type of operation and configuration on the 
environment, different ports are required to enable the connections. There are 
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different requirements for operations such as backup, restore and 
administration.

Typical operations
Under typical operations, NetBackup connections are established requiring a 
call-back or not, as follows:

■ For those connections that do not require a call-back, all communication is 
performed on the established connection between the two computers. A 
connection that does not require a call-back requires no additional 
discussion. Such connections can be considered a special case of those that 
require a call-back.

■ For those connections that require a call-back, the computer making the 
connection (the source computer) passes information to the other computer 
(the destination computer) so that it can call-back to the source computer. 
This is known as the traditional call-back method.

The traditional call-back method assumes that more than one connection is 
needed between two computers in order to accomplish a particular operation. 
The following steps describe the procedure used to establish the connections:

1 The destination is actively listening on a well known port number.

2 The source computer determines the well known port number on the 
destination computer to which it needs to connect.

3 The source computer creates a socket and binds it to a local port number. 
This is the socket that the source computer will use to connect to the 
destination computer.

4 The source computer creates another socket and binds it to a local port 
number. This is the port number to which the destination computer will call 
back. This port number is the call-back port number. The source computer is 
actively listening on this port number.

5 The source computer connects to the well known port number on the 
destination computer.

6 The source computer passes the call-back port number to the destination 
computer.

7 The destination computer creates a socket and binds it to a local port 
number.

8 The destination computer connects to the call-back port number on the 
source computer.
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9 At this point, there are two active connections between the two computers. 
Data can be sent and/or received on either of the connections.
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NetBackup ports

NetBackup communicates between computers by using a combination of 
registered and dynamically allocated ports. The following sections describe 
these ports.

Registered ports
Registered ports are those that are registered with the Internet Assigned 
Numbers Authority (IANA) and are assigned permanently to specific NetBackup 
services. For example, the port for the NetBackup client daemon, bpcd, is 13782. 
A system configuration file contains the default port numbers for each daemon. 
These files are as follows:

■ On UNIX systems, you can specify ports in the /etc/services file.

■ On Windows systems, you can specify ports in the 
%systemroot%\System32\drivers\etc\services file.

Media Manager services include tape library control daemons. These daemons 
accept connections from daemons on other servers that are sharing the same 
library. For more information, see the services file on the media server to 
determine the ports required for a specific library.

Dynamically allocated ports
Dynamically allocated ports are assigned, as needed, from ranges you can 
specify on NetBackup clients and servers. In addition to the range of numbers, 
you can configure the following for dynamically allocated ports:

■ Whether NetBackup selects a port number at random from the allowed 
range or starts at the top of the range and uses the first one available.

■ Whether connections to bpcd on a client use reserved or non-reserved ports.
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Overriding and modifying port numbers
Symantec suggests that you use the default port settings for NetBackup services 
and Internet service ports.

If you need to modify the port number for a daemon, make sure you modify the 
port number so that it is the same for all NetBackup master servers, media 
servers, and client systems that communicate with each other.

Default port numbers
The following sections show the NetBackup connections and ports used in 6.0 
and in pre-6.0 systems.

Default port numbers for NetBackup 6.0
The following figures show the port connections between various NetBackup 
components.

Figure 2-1 shows an example port connection and explains how the following 
figures represent the port connections.

Figure 2-1 Port connections key

VxSS Authentication 
Server

vrts-at-port/2821

Port name

Source port number, taken from the client port window or 
the client reserved port window

Client Port Window

Authenticates user or machine.

Destination port number

Purpose

Destination
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Minimum Master Server Outgoing Connections

Figure 2-2 6.0 Master Server Minimal Outgoing Port Connections - Part 1

6.0 Master Server

EMM Server
- Access information about device, media, and storage 
databases.

- Determines NetBackup version of media server.
- Starts bpbrm for backups and restores.
- Starts bptm to manage tape storage units.
- Starts bpstsinfo to manage disk storage units.
- Accesses or updates host properties for media server.

- Determines NetBackup version of client.
- Gets list of mount points for multistreamed backups.
- Accesses or updates host properties for client.

6.0 Media Server

6.0 Client

Client port window

Client port window

- Authenticates user for database backup, user backup, or 
restore.

Client with legacy 
security

Client port window

- Gets list of mount points for multistreamed backups.
- Accesses or updates host properties for client.

5.x ClientClient reserved port 
window

5.x Media Server

- Starts bpbrm for backups and restores.
- Starts bptm to manage tape storage units.
- Accesses or updates host properties for media server.

- Determines NetBackup version of media server.

Client port window

Client reserved port 
window

Client port window

vnetd/13724

vnetd/13724

bpcd/13782

veritas_pbx/1556

vnetd/13724

Client reserved port 
window - Determines NetBackup version of client.

bpcd/13782

vnetd/13724
5.x Client

vopied/13783

Client port window veritas_pbx/1556
- Connect-back for job information.
- Connect-back for resource information.
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Figure 2-3 6.0 Master Server Minimal Outgoing Port Connections - Part 2

6.0 Master Server

VxSS Authentication 
Server

- Authenticates user or machine.

- Accesses volume database for 5.X media server.
5.X VDB Host

Client port window

- Determines NetBackup version of client.

NetWare Client

Client port window

Administrative 
Console or Java 

Server
- Authenticates and authorizes user for administration.

- Connect-back for activity monitor.

Client port window

Client port window

Client port window

veritas_pbx/1556

vnetd/13724

vopied/13783

vrts-at-port/2821

vnetd/13724

If using legacy security:

Administrative 
Console or Java 

Server

If NBAC is enabled:

Client port window

- Authorizes user for administration.

vrts-auth-port/4032 VxSS Authorization 
Server

If NBAC is enabled:

Client reserved port 
window - Accesses or updates host properties for client.

bpcd/13782

Client port window

- connect-back for job monitor.

veritas_pbx/1556
Java Console

- Authenticates user for database backup, user backup, or 
restore.

Client with legacy 
security

Client port window vopied/13783
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Figure 2-4 6.0 Media Server Minimal Outgoing Port Connections - Part 1

vnetd/13724

6.0 Media Server

veritas_pbx/1556
EMM Server

vnetd/13724

6.0 Client

bpcd/13782

5.x Client

bpcd/13782

6.0 Media Server

veritas_pbx/1556

NetWare Client

6.0 Master Server

Client port window

Client port window

Client port window

Client port window

Client port window

Client reserved port 
window

Client port window

Client reserved port 
window

- Accesses legacy policy information from bpdbm.
- Accesses legacy job information from bpjobd.
- Updates image catalog information to bpdbm.
- Makes miscellaneous requests to bprd.

- Accesses job information.
- Accesses resource information.

- Establishes sockets to other media servers for 
duplication, disk staging, and synthetics.

- Accesses information about device, media, and storage 
databases.

- Determines the NetBackup version of the client.
- Establishes sockets to back up or restore a client.

- Establishes sockets to back up or restore a cent.

- Determines NetBackup version of client.

Client reserved port 
window

- Establishes sockets to back up or restore a client.

- Determines Net backup version of client.

vnetd/13724

vnetd/13724

vnetd/13724
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Figure 2-5 6.0 Media Server Minimal Outgoing Port Connections - Part 2

Figure 2-6 5.x Media Server Minimal Outgoing Port Connections

Client port window

vopied/13783Client port window

VxSS Authentication 
Server

VxSS Authorization 
Server

Client port window

If NBAC is enabled:

If NBAC is enabled:

6.0 Media Server

If using legacy security:

Administrative Console 
or Java Server- Authenticates and authorizes user for administration.

- Authenticates user or machine.

- Authorizes user for administration.

vrts-auth-port/4032

vrts-at-port/2821

bpcd/13782

6.0 Master

vnetd/13724

5.x Client

5.x Media Server

vnetd/13724Client port window

5.x VDB Host

6.0 Master

vnetd/13724Client reserved port 
window

- Accesses legacy policy information from bpdbm.
- Accesses legacy job information from bpjobd.
- Updates image catalog information to bpdbm.
- Makes miscellaneous requests to bprd.

- Connects back for bpcd requests from the master.

Client reserved port 
window

- Establishes initial socket for backup or restore.

Client port window

- Accesses legacy volume database information.

Client port window VxSS Authentication 
Server

If NBAC is enabled:

- Authenticates user or machine.

vrts-at-port/2821
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On the 5.x media server, verify the following:

■ That the Host Properties display specifies using vnetd instead of the 
Daemon Port connections.

■ That the following entries exist in both the bp.conf and vm.conf files:

CONNECT_OPTIONS=master 0 1 0

CONNECT_OPTIONS=vdb 0 1 0

where:

These settings minimize port use.

You can also specify these settings using the Host Properties > Firewall 
GUI. Select VNETD port for BPCD connect back. Select Automatic for 
Daemon connection port.

Minimum Enterprise Media Manager Outgoing Connections

Figure 2-7 Enterprise Media Manager (EMM) Minimal Outgoing Port 
Connections

master Specifies the master server hostname.

vdb Specifies the volume database hostname.

Administrative Console 
or Java Server

veritas_pbx/1556

- connect-back for information about device, media and 
storage databases.

veritas_pbx/1556

- Connect-back for information about device, media and 
storage databases.

6.0 Media Server

EMM Server

Client port window

Client port window

veritas_pbx/1556

- Connect-back for information about device, media and 
storage databases.

6.0 Master ServerClient port window

- Authorizes user for administration.

VxSS Authorization 
Server

Client port window vrts-auth-port/4032

Client port window
VxSS Authentication 

Server

If NBAC is enabled:

- Authenticates user or machine.

vrts-at-port/2821
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Minimum Client Outgoing Connections

Figure 2-8 6.0 Client (Non-NetWare) Minimal Outgoing Port Connections 

Figure 2-9 5.x Client (Non-NetWare) Minimal Outgoing Port Connections 

VxSS Authentication 
Server

vrts-at-port/2821

6.0 Client

vnetd/13724 6.0 Master ServerClient port window

Client port window

- Makes backup, restore, and miscellaneous requests to 
bprd.

- Authenticates user or machine.

vnetd/13724

5.x Client

vnetd/13724

6.0 Master Server

Client port window

6.0 Media Server

vnetd/13724Client reserved port 
window

Client reserved port 
window

- Makes backup, restore, and miscellaneous requests to 
bprd.

- Connect back for bpcd requests from the master.

- Connect back for bpcd requests from the media server.

Client port window VxSS Authentication 
Server

If NBAC is enabled:

- Authenticates user or machine.

vrts-at-port/2821
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On the 5.x client, verify the following:

■ That the Host Properties display specifies using vnetd instead of the 
Daemon Port connections.

■ That the following entry exists in the bp.conf file:

CONNECT_OPTIONS=master 0 1 0

where:

These settings minimize port use.

You can also specify these settings using the Host Properties > Firewall 
GUI. Select Automatic for Daemon connection port.

Figure 2-10 4.5 Client (Non-NetWare) Minimal Outgoing Port Connections with 
Mixed Versions

master Specifies the master server hostname.

4.5 Client

6.0 Master Server

bprd/13720Client reserved port 
window

Client reserved port 
window

6.0 Media Server
vnetd/13724Client reserved port 

window

vned/13724

-Makes backup, restore, and miscellaneous requests to bprd.

-Connect back for bpcd requests from the master.

-Connect back for bpcd requests from the media server.
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Figure 2-11 6.0 NetWare Client Minimal Outgoing Port Connections

Figure 2-12 5.x NetWare Client Minimal Outgoing Port Connections with Mixed 
Versions

6.0 NetWare Client

vnetd/13724

6.0 Master Server

Client reserved port 
window

vnetd/13724
6.0 Media ServerClient port window

bprd/13720Client port window

- Makes backup, restore, and miscellaneous requests to bprd.

- Connect back for bpcd requests from the master.

- Connect back for bpcd requests from the media server.

Random port from server reserved port windowClient reserved port 
window

Client reserved port 
window

bprd/13720Client port window

Random port from server reserved port window 6.0 Media Server

6.0 Master Server

5.x NetWare Client

- Connect back for bpcd requests from the master.

- Makes backup, restore, and miscellaneous requests to bprd.

- Connect back for bpcd requests from the media server.
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Minimum Java Server or Windows Administration 
Console Outgoing Connections

Figure 2-13 Java Server or Windows Administration Console Minimal Outgoing 
Port Connections

VxSS Authentication 
Server

6.0 Master Server

Administrative Console 
or Java Server

vrts-at-port/2821

EMM Serververitas_pbx/1556

vnetd/13724

vnetd/13724

veritas_pbx/1556

5.x Media Server
bpcd/13782

vnetd/13724

vnetd/13724

Media Server

5.X VDB Host

Client port window

Client port window

Client port window

Client port window

Client port window

Client port window

Client port window

Client port window

- Accesses job manager (nbjm).

- Manages policies.
- Manages host properties.
- Starts manual backups and restores.

- Accesses devices.

- Accesses device, media, and storage unit databases.

- Accesses the legacy volume database.

- Establishes user credentials for administration.

- Accesses devices

- Accesses devices

If NBAC is enabled:
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Figure 2-14 Java Console Minimal Outgoing Port Connections

Minimum Volume Database Host Outgoing Connections

Figure 2-15 5.x Volume Database Host and Mixed Versions Minimal Outgoing 
Port Connections

On the 5.x volume database host, verify the following:

■ That the Host Properties display specifies using vnetd instead of the 
Daemon Port connections.

■ That the following entry exists in the vm.conf file:

CONNECT_OPTIONS=master 0 0 0

CONNECT_OPTIONS=media 0 0 0

where:

These settings minimize port use.

You can also specify these settings using the Host Properties > Firewall 
GUI. Select Automatic for Daemon connection port.

vnetd/13724Client port window

vnetd/13724Client port window

Java Console

6.0 Master Server

Java Server

veritas_pbx/1556Client port window

- Establishes sockets with the legacy job manager (bpjobd).

- Establishes sockets with the job manager (nbjm).

- Establishes sockets with the Java server (bpjava).

Master Server

5.x Volume 
Database Host

Client port window

5.x Media Servervnetd/13724Client port window

- Accesses the legacy volume manager on a media server.

vnetd/13724

- Accesses the legacy volume manager on the master server.

master Specifies the master server hostname.

media Specifies the media server hostname.



19NetBackup ports
Default port numbers
Default port numbers for NetBackup 6.0
Table 2-1 lists the well known ports that are used within a NetBackup 
environment. Not all of the daemons are available in a base NetBackup 
installation. Some of them are enabled or used by add-on products, and the 
right-most column indicates which product uses the daemon.

NetBackup 6.0 and later will use additional ports when connected to NetBackup 
5.1 and earlier. See the Default port numbers for NetBackup 4.5-5.1 section for 
more details.

Default port numbers for NetBackup 4.5-5.1
Table 2-2 lists the well-known ports that are used within a NetBackup 
environment. Not all of the daemons are available in a base NetBackup 
installation. Some of them are enabled or used by add-on products, and the 
right-most column indicates which product uses the daemon.

Table 2-1 Port Numbers for NetBackup 6.0

Daemon or 
Process

Port 
Number

Product Purpose

VNETD 13724 NetBackup Network daemon.

VOPIED 13783 NetBackup One-time Password user authentication daemon. It authenticates 
user names, hosts names, and group/domain names. On UNIX 
clients, this daemon can only be run in standalone mode. On 
Windows clients, it always runs under the supervision of 
BPINETD.EXE.

VERITAS_PBX 1556 VxPBX VERITAS Public Exchange Service

VRTS-AT-PORT 2821 VxAT VERITAS Authentication Service

VRTS-AUTH-PORT 4032 VxAZ VERITAS Authorization Service

Table 2-2 Port Numbers for NetBackup 4.5-5.1

Daemon or 
Process

Port 
Number

Product Purpose

ACSDa 13702b Media 
Manager

Automated Cartridge System (ACS) daemon. One of the robotic 
daemons.
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BPCD 13782c NetBackup NetBackup Client Daemon.

On UNIX clients, this daemon is run typically through inetd(1M) 
or xinetd(8). It can also be run in standalone mode.

On Windows clients, it always runs under the supervision of 
BPINETD.EXE. There is a NetBackup specific configuration 
parameter for this daemon. If the port number is changed within 
the NetBackup configuration, the software updates the port 
number in the services file.

BPDBMa 13721b NetBackup NetBackup database manager daemon.

BPJAVA_MSVCa 13722c NetBackup NetBackup-Java application server authentication service 
program.

BPJOBDa 13723b NetBackup NetBackup Jobs Database Management Daemon.

BPRDa 13720b NetBackup BPRD is the NetBackup Request Daemon.

On Windows computers, there is a NetBackup specific 
configuration parameter for this daemon. If the port number is 
changed within the NetBackup configuration, the software updates 
the port number in the services file.

LMFD and LMFCDa 13718b Media 
Manager

Library Management Facility (LMF) daemon and control daemon. 
One of the robotic daemons.

NDMP 10000 NetBackup 
for NDMP

Network Data Management Protocol. NDMP servers adhere to this 
protocol and listen on port 10000 (by default) for NDMP clients to 
connect to them.

ODLDa 13706b Media 
Manager

Optical Disk Library (ODL) daemon. One of the robotic daemons.

RSMDa 13719b Media 
Manager

Removable Storage Manager (RSM) process. One of the robotic 
processes.

TL4Da 13713b Media 
Manager

Tape Library 4MM (TL4) daemon. One of the robotic daemons.

TL8D and TL8CDa 13705b Media 
Manager

Tape Library 8MM (TL8) daemon and control daemon. One of the 
robotic daemons.

TLDD and TLDCDa 13711b Media 
Manager

Tape Library DLT (TLD) daemon and control daemon. One of the 
robotic daemons.

TLHD and TLHCDa 13717b Media 
Manager

Tape Library Half-inch (TLH) daemon and control daemon. One of 
the robotic daemons.

Table 2-2 Port Numbers for NetBackup 4.5-5.1 (Continued)

Daemon or 
Process

Port 
Number

Product Purpose
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TLMDa 13716b Media 
Manager

Tape Library Multimedia (TLM) daemon. One of the robotic 
daemons.

TS8D a 13709b Media 
Manager

Tape Stacker 8MM (TS8) daemon. One of the robotic daemons.

TSDD a 13714b Media 
Manager

Tape Stacker DLT (TSD) daemon. One of the robotic daemons.

TSHDa* 13715b Media 
Manager

Tar Stacker Half-inch (TSH) daemon. One of the robotic daemons.

VMD 13701b Media 
Manager

Media Manager volume daemon.

VNETD 13724 NetBackup Network daemon.

VOPIED 13783 NetBackup One-time Password user authentication daemon. It authenticates 
user names, hosts names, and group/domain names. On UNIX 
clients, this daemon can only be run in standalone mode. On 
Windows clients, it always runs under the supervision of 
BPINETD.EXE.

VSM 13699 Storage 
Migrator

The Storage Migrator for UNIX.

VRTS-AT-PORT 2821 VxAT VERITAS Authentication Service

VRTS-AUTH-PORT 4032 VxAZ VERITAS Authorization Service

a. This is a standard NetBackup standalone daemon.

b. This service can also be accessed by the vnetd (13724) port number. In NetBackup 6.0, the default is to use the vnetd port number. 
For pre-6.0, the default is to use the legacy port number.

c. This service can also be accessed by the vnetd (13724) port number for NetBackup 6.0. In NetBackup 6.0, the default is to use the 
vnetd port number. For pre-6.0, the legacy port number is always used.

Table 2-2 Port Numbers for NetBackup 4.5-5.1 (Continued)

Daemon or 
Process

Port 
Number

Product Purpose
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Chapter
 3
Configuration options

This chapter describes how to configure the various non-default port 
configurations that you might need in your environment to support firewalls 
and other features.

You can set the configuration options in this chapter from both the graphical 
user interface (for Java or Windows) or from the command line (on UNIX or 
Windows). The instructions in this chapter describe how to set the configuration 
options using the graphical user interface. For information on setting 
configuration options from the command line, see “Configuring port usage 
without a GUI” on page 45.

Accept connections from non-reserved ports
The Accept connections from non-reserved ports setting specifies that the 
NetBackup client service (bpcd) can accept remote connections from 
non-reserved ports, which are those with port numbers 1024 and greater. If this 
setting is not specified, bpcd requires remote connections to come from 
reserved ports, which are ports numbers less than 1024. The Accept 
connections from non-reserved ports setting is useful when NetBackup clients 
and servers are on opposite sides of a firewall.

For NetBackup 5.1 and earlier, this setting is disabled by default, which has the 
following effects:

■ NetBackup does not accept remote connections from non-reserved ports.

■ The source ports for connections to bpcd use reserved ports. If this setting 
is specified on a client/server, and you want to use non-reserved ports, the 
server connecting to the client/server must also be configured to use 
non-reserved ports for the client.

For NetBackup 6.0 and later, this setting is enabled by default. If the system 
making the bpcd connection is NetBackup 6.0 or later and the system accepting 
the bpcd connection is NetBackup 6.0 or later (other than the Netware client), 
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the default is to always use non-reserved port numbers. If the system accepting 
the bpcd connection is NetBackup 5.1 or earlier or a Netware client, the default 
is to use reserved ports.

To enable nonreserverd ports from the Java or Windows interface

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Universal Settings.

A display similar to the following appears:

Figure 3-1 Universal settings

4 Check Accept connections from non-reserved ports.
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Use random port assignments
The following sections describe how to configure random port assignments in 
the NetBackup configuration and in the media manager configuration.

Random port assignments in the NetBackup configuration
The Use random port assignments setting specifies that when NetBackup 
requires a port number for communication with NetBackup on other computers, 
it can randomly choose one from those that are free in the allowed range.

Example If the range is from 1023 through 5000, it 
chooses randomly from the numbers in this 
range.

If this setting is changed from the default, NetBackup chooses numbers 
sequentially, starting with the highest number that is available in the allowed 
range.

Example If the range is from 1023 through 5000, 
NetBackup chooses 5000, assuming it is free. 
If 5000 is being used, NetBackup chooses port 
4999. This setting is enabled by default.

To disable random port assignments from the Java or Windows interface

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Universal Settings.

4 Uncheck Use random port assignments.

Random port assignments in the Media Manager configuration
The random ports setting for Media Manager works the same way as it does for 
the general NetBackup configuration.

The Use random port assignments setting specifies that when Media Manager 
requires a port number for communication with Media Manager on other 
computers, it can randomly choose one from those that are free in the allowed 
range.

Example If the range is from 1023 through 5000, it 
chooses randomly from the numbers in this 
range.
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If this setting is changed from the default, Media Manager chooses numbers 
sequentially, starting with the highest number that is available in the allowed 
range.

Example If the range is from 1023 through 5000, Media 
Manager chooses 5000, assuming it is free. If 
5000 is being used, Media Manager chooses 
port 4999. This setting is enabled by 
default.

Note: Specify the same port selection for NetBackup as you do for Media 
Manager. That is, if you specify random ports in the NetBackup configuration, 
also specify random ports in the Media Manager configuration.

Specifying Firewall connection options on a 
NetBackup server or client

The connect options specify how connections are made between computers. You 
specify the settings on the computer that initiates the connection (source 
computer) for the server to which it connects (destination computer).

Example If there is a firewall between the master 
server and the media servers, you can specify 
the settings from the master server (source 
computer) for each of the media servers 
(destination computers) to which the master 
server connects.

You can define the connect options between the source computer and specific 
destination computers. If the source computer is running NetBackup 6.0 or 
later, you also can set default connection options that apply to all other 
destination computers.

To specify Firewall default connect options for a NetBackup 6.0 or later 
source computer from the Java or Windows interface

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Firewall.

4 Click Change in the Default Connect Options pane.

A display similar to the following appears:
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Figure 3-2 Default connect options

You can set the following connection options from the display:

■ Ports (reserved versus non-reserved)

■ BPCD connect-back

■ Daemon connection port

If the source computer is a NetBackup client (not a server), only the Daemon 
connection port setting will apply.

The following sections describe these settings.

Ports
The use non-reserved ports setting determines whether the source computer 
connects to bpcd on destination computers using a reserved or a non-reserved 
source port number.

By default, the use reserved ports setting is specified. This means that the 
source computer connects to bpcd on destination computers using a reserved 
port number.

If you change the default, use non-reserved ports goes into effect. This means 
that the source computer connects to bpcd on destination computers using a 
non-reserved port number. In addition, if use non-reserved ports is specified, 
configure the host to allow connections on non-reserved ports. For 
reconfiguration information, see “Accept connections from non-reserved ports” 
on page 23.
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Note: This setting generally has no effect if both the source and destination 
computers are NetBackup 6.0 or later and the destination computer is not a 
Netware client. By default, non-reserved ports are always used in that case. See 
the note in the Daemon connection port description.

BPCD connect-back
The BPCD connect-back setting specifies whether the host can be connected to 
by another computer using the legacy bpcd random port call back method or by 
using the VERITAS Network Daemon (vnetd). By default for NetBackup 5.1 or 
earlier, the BPCD connect-back is Random port. This means that the connection 
uses the legacy random port call-back method.

If BPCD connect-back is VNETD port, other computers connect to the host using 
vnetd, which does not require random port call back. This is the default for 
NetBackup 6.0 and later.

Note: This setting generally has no effect if both the source and destination 
computers are NetBackup 6.0 or later and the destination computer is not a 
Netware client. By default, call-back is not used in that case. See the note in the 
Daemon connection port description.

Daemon connection port
The Daemon connection port setting specifies one of the following methods for 
computers to use when connecting to the host:

■ Automatic (default for NetBackup 6.0 and later). Specifies that connections 
to the daemons on the host be made using vnetd if possible. If it is not 
possible to use vnetd, the connection is made using the daemon's legacy 
port number.

■ VNETD only. Specifies that connections to the daemons on the host be made 
using vnetd only. If your firewall rules prevent connecting to the host using 
the legacy port number, make sure that vnetd is used.

■ Daemon port only (default for NetBackup 5.1 and earlier). Specifies that 
connections to the host be made using only the legacy port number.
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Note: For NetBackup 5.1 and earlier, connections to bpcd are always made with 
the legacy bpcd port number. Connections to bpcd can be made with the vnetd 
port number if both the source and destination computers are NetBackup 6.0 or 
later and the destination computer is not a Netware client. When bpcd 
connections are made using the vnetd port number, the Ports and BPCD 
connect-back settings are ignored. The default in that case is to use 
non-reserved source port numbers, the vnetd destination port number, and no 
call-back.

Note: Connections to vopied, veritas_pbx, veritas-at-port, and veritas-auth-port 
are not affected by this setting. Those connections always use the legacy or 
IANA defined port numbers.

To specify Firewall connect options for a source computer to apply to specific 
destination computers from the Java or Windows interface

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Firewall.

4 Click Add in the Hosts pane. Add a destination host (usually another 
NetBackup server) to hosts list shown in the following figure.
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Figure 3-3 Master Server Properties

5 Select the appropriate values from the BPCD connect back, Ports, and 
Daemon connection port menu items. The values available in these menu 
items include the values available in the Default Connect Options described 
above. In addition, you can specify Use default connect options which 
means that the value for the specified destination host will use the value 
from Default Connect Options instead.

Specifying Firewall connection options on Media 
Manager

In NetBackup 6.0 and later, the Media Manager defaults to the NetBackup 
connection options described above unless overridden by the vm.conf 
CONNECT_OPTION entries. For NetBackup 5.1 and earlier, Media Manager 
connection options must be specified in vm.conf.

Unlike the NetBackup master servers or clients, there is no graphical user 
interface to use to change the firewall connections for Media Manager. For 
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information on changing the vm.conf file for Media Manager, see “Configuring 
port usage without a GUI” on page 45.

Specifying NetBackup-Java connection options
Unlike the NetBackup master servers or clients, there is no graphical user 
interface to use to change the NBJAVA_CONNECT_OPTION.

The /usr/openv/java/nbj.conf file on UNIX and the 
nbjava_install_path\java\setconf.bat file on Windows contain 
configuration settings that you might want to change if you are configuring 
ports. These options are as follows:

NBJAVA_CONNECT_OPTION=setting

NBJAVA_CLIENT_PORT_WINDOW=n m

For information on changing these settings, see one of the following manuals:

■ NetBackup Administrator’s Guide for UNIX and Linux, Volume I

■ NetBackup Administrator’s Guide for Windows, Volume I

Specifying client attributes
The Client Attributes tab lets you specify several connect options. These options 
all define how a master or media server can connect to a client. 

Example You can specify reserved or non-reserved 
ports, 

Note: If a master or media server is configured to connect to a client using 
non-reserved ports, use the procedure that follows, “Specifying ports (reserved 
or non-reserved)” on page 32, to configure that client to accept remote 
connections from non-reserved ports.

To specify client attributes from the Java or Windows interface

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Client Attributes.

A display similar to the following appears:
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Figure 3-4 Client attributes - main screen

The following sections describe how to enable or disable the following settings:

■ Specifying ports (reserved or non-reserved ports)

■ Specifying a BPCD connect-back method

■ Specifying a Daemon connection port

Specifying ports (reserved or non-reserved)
By default, a master or media server uses a reserved port when it connects to 
bpcd on a client. This means that the Reserved ports selection is in effect. You 
can use the following procedure to change this setting.

To specify reserved or non-reserved ports

1 Make sure that you are in the Client Attributes display.

For information on how to get to the Client Attributes display, see the 
procedure “To specify client attributes from the Java or Windows interface” 
on page 31.

2 Make sure that the client(s) you want to configure show in the Clients pane.
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To add a client, click Add... and type the name of the client you want to add 
in the dialog box that appears. When you are finished adding clients, click 
Close.

3 Click the Connect Options tab.

4 In the Ports dropdown list, select either Reserved ports, Non-reserved 
ports, or Use default connect options.

The display for this is as follows:

Figure 3-5 Ports dropdown list

■ Selecting Reserved ports specifies that master and media server use a 
reserved port when connecting to bpcd on this client.

■ Selecting Non-reserved ports specifies that master and media servers 
use a non-reserved port when connecting to bpcd on the client.

■ Selecting Use default connect options specifies that master and media 
servers use the CONNECT_OPTIONS or DEFAULT_CONNECT_OPTIONS 
that are defined on the master or media server that connects to the 
client. Default.

5 Click Apply when you are finished specifying ports.

6 Click OK to exit from the Client Attributes interface.
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Note: By default, if both the server and the client are NetBackup 6.0 or later and 
the client is not Netware, this setting is not applicable. Non-reserved ports are 
always used in that case. See the note in the description of the Daemon 
connection port setting below.

Specifying a BPCD connect-back method
The BPCD connect-back method specifies how the client responds when a 
master or media server connects to bpcd on the client. 

By default, the client connects back to the master or media server on the VNETD 
port number. This means that the VNETD port selection is in effect. You can use 
the following procedure to change this setting.

To specify a BPCD connect-back method

1 Make sure that you are in the Client Attributes display.

For information on how to get to the Client Attributes display, see the 
procedure “To specify client attributes from the Java or Windows interface” 
on page 31.

2 Make sure that the client(s) you want to configure show in the Clients pane.

To add a client, click Add... and type the name of the client you want to add 
in the dialog box that appears. When you are finished adding clients, click 
Close.

3 Click the Connect Options tab.

4 In the BPCD connect back dropdown list, select either Random port, VNETD 
port, or Use default connect options.

This display is as follows:
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Figure 3-6 BPCD connect back dropdown list

■ Selecting Random port specifies that the client connect back to the 
master and media server using a random port number.

■ Selecting VNETD port specifies that the client connect back to the 
master and media server using the vnetd port number.

Selecting Use default connect options specifies that the client connect back to 
the master and media server the CONNECT_OPTIONS or 
DEFAULT_CONNECT_OPTIONS that are defined on the master or media server 
that connects to the client. Default.

5 Click Apply when you are finished specifying a method.

6 Click OK to exit from the Client Attributes interface.

Note: By default, if both the server and the client are NetBackup 6.0 or later and 
the client is not Netware, this setting is not applicable. Connect back is not used 
in that case. See the note in the description of the Daemon connection port 
setting below.

Specifying a Daemon connection port
The Daemon connection port specifies which destination port the server uses to 
connect to the client. By default if both server and client are NetBackup 6.0 or 
later, the connection will be on the vnetd port number. All other server to client 
bpcd connections are on the legacy bpcd port number. You can use the following 
procedure to change this setting.
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To specify a Daemon connection port

1 Make sure that you are in the Client Attributes display. For information on 
how to get to the Client Attributes display, see the procedure “To specify 
client attributes from the Java or Windows interface” on page 31.

2 Make sure that the client(s) you want to configure show in the Clients pane. 
To add a client, click Add... and type the name of the client you want to add 
in the dialog box that appears. When you are finished adding clients, click 
Close.

3 Click the Connect Options tab.

4 In the Daemon connection port dropdown list, select either Automatic, 
VNETD port only, Daemon port only, or Use default connect options.

This display is as follows:

Figure 3-7 Client Attributes

■ Selecting Automatic specifies that the server will attempt to connect to 
bpcd on the client using the vnetd port number. If that fails, the server will 
attempt to connect to bpcd on the client using the legacy bpcd port number.

■ Selecting VNETD only specifies that the server will attempt to connect to 
bpcd on the client using the vnetd port number. Do not select this option if 
the client is NetBackup 5.1 or earlier or if the client is Netware.
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■ Selecting Daemon port only specifies that the server will attempt to connect 
to bpcd on the client using the legacy bpcd port number.

■ Selecting Use default connect options specifies the port number used by 
the server to connect to bpcd on the client using the CONNECT_OPTIONS 
or DEFAULT_CONNECT_OPTIONS that are defined on the master or media 
server that connects to the client. Default.

5 Click Apply when you are finished specifying a method.

6 Click OK to exit from the Client Attributes interface.

Note: For NetBackup 5.1 and earlier, connections to bpcd are always made with 
the legacy bpcd port number. Connections to bpcd can be made with the vnetd 
port number if both the server and client are NetBackup 6.0 or later and the 
client is not Netware. When bpcd connections are made using the vnetd port 
number, the Ports and BPCD connect-back settings are ignored. The default in 
that case is to use non-reserved source port numbers, the vnetd destination 
port number, and no connect-back.

Specifying port ranges
The following sections describe how to specify the numbers for the ranges of 
ports.

Note: For all port windows, if you specify a 0 in the From box, the software uses a 
non-reserved port of the operating system’s choosing.

To specify port ranges

1 In the NetBackup Administration Console, expand NetBackup Management 
> Host Properties > Master Servers.

2 Double click the host you want to configure.

3 Click Port Ranges.

A display similar to the following appears:
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Figure 3-8 Port ranges

Use Table 3-1 as a guide when specifying ports.

Table 3-1 Port ranges 

Port Purpose Default Range

Client Port Window Specifies the range of non-reserved source port numbers that this 
computer uses to connect to most NetBackup services.

0 - 0

The operating 
system chooses 
the port.

Client Reserved Port 
Window

Specifies the range of reserved source port numbers that this 
computer uses to connect to bpcd with the legacy bpcd destination 
port number.

512 - 1023

Server Port Window Specifies the range of non-reserved destination port numbers that 
other computers use to connect to this computer for bpcd connect 
back.

1024 - 5000

Server Reserved Port 
Window

Specifies the range of reserved destination port numbers that other 
computers use to connect to this computer for bpcd connect back

512 - 1023
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4 Click Apply

5 Click OK

The Client Reserved Port Window, Server Port Window, and Server Reserved 
Port Window settings are not applicable to NetBackup clients.

By default, the Server Port Window and Server Reserved Port Window settings 
are not used for NetBackup 6.0 or later unless connecting to bpcd on a 
NetBackup 5.1 or earlier Netware client.

By default, Client Reserved Port Window setting is not used for NetBackup 6.0 
or later if connecting to a destination computer running NetBackup 6.0 or later 
that is not a Netware client.

Miscellaneous port numbers
The following sections describe the BPJAVA_PORT, VNETD_PORT, BPCD, and 
BPRD ports.

BPJAVA_PORT and VNETD_PORT
BPJAVA_PORT is the configured port for the bpjava_msvc daemon process. 
VNETD_PORT is the configured port for the vnetd daemon process. These ports 
are registered with IANA.

Caution: Symantec does not recommend changing these ports.

If the ports for these processes need to be changed, make the change on all 
NetBackup hosts in the relevant NetBackup cluster as described in the 
NetBackup Installation Guide for UNIX or the NetBackup Installation Guide for 
Windows. In addition, specify the value in the corresponding nbj.conf option.

BPCD and BPRD ports
The BPCD port is the configured port for the bpcd daemon process. The BPRD 
port is the configured port for the bprd daemon process. These ports are 
registered with IANA.

Caution: Symantec does not recommend changing these ports.

If the ports for these processes need to be changed, make the change on all 
NetBackup hosts.
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On Windows hosts, In addition to making the change in all the relevant 
services files, use the following procedure to set the value for all Windows 
computers:

To change the ports for BPCD and BPRD on Windows

1 On Windows, click through Start > All Programs > VERITAS NetBackup > 
Backup, Archive, and Restore.

2 In the Backup, Archive, and Restore window, click File > NetBackup Client 
Properties.

3 Select the Network tab.

4 Change the values.

5 Click OK.

If the services file is not changed and the bpcd port is changed using the 
preceding procedure, the change is reflected in the NetBackup configuration. At 
this point, a difference exists between the value that is in the NetBackup 
configuration and the services file. The next time the NetBackup Client Service 
is started on the computer; it will automatically update the services with the 
value that appears in the NetBackup configuration.
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ICM port usage

Windows system administration console
By default, the NetBackup Windows administration console pings the computers 
it communicates with to ensure that they are alive before attempting to connect 
to them. If the ICMP protocol is blocked in a network, the NetBackup Windows 
administration console might no longer function.

You can use the following procedure to disable the ping that the NetBackup 
Windows administration console performs by default.

Note: For 6.0 release, ping by default is already disabled. For 5.x releases, use the 
following procedure to disable ping.

To disable the ping on a NetBackup Windows administration console

1 Select the View menu.

2 Select the Options menu item.

3 When the dialog appears, select the Administration Console tab.

4 On that tab, select the box for Disable ping connection checking.
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NDMP port usage

ICMP pinging NDMP
On UNIX systems, the NetBackup avrd process uses the Internet Control 
Message Protocol (ICMP) when it pings NDMP hosts to verify network 
connectivity. If a ping fails, NetBackup skips this particular device, which leaves 
the status of the drive as up.

On Windows systems, NetBackup does not ping the NDMP device. It tries the 
connection. If the network is experiencing connectivity problems, this method 
can take longer because as NetBackup waits for a timeout.

NDMP in a firewall environment
If you are using an NDMP storage unit in a firewall environment, make sure you 
know the different types of NDMP backups to be performed. The backup type 
determines which ports need to be opened in the firewall. The following 
paragraphs describe the types of NDMP backups and how they pertain to 
firewall use. These backup types include local, 3-way and remote NDMP, remote 
NDMP and local and 3-way TIR.

■ For local operations, the DMA needs access to port 10,000 on the NDMP 
server. In this case, the one NDMP server is both the NDMP tape server and 
the NDMP data server.

■ For 3-way and remote NDMP, the DMA needs access to port 10,000 on the 
NDMP tape server and the NDMP data server. Also, there cannot be a 
firewall between the NDMP tape server and the NDMP data server because 
there is no control over the TCP/IP ports used for the data movement.

■ For remote NDMP (5.0 / 5.1), it is not advisable to put a firewall between the 
DMA and the NDMP hosts. This is because the DMA can be on the same 
computer as the NDMP tape server. In this case, you need an unlimited 
number of ports available to perform the data movement between the 
NDMP tape server and the NDMP data server.

■ For local and 3-way TIR, the data requires an unlimited number of ports 
available because NetBackup has no control over the ports used.
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ACS storage server interface

ACSSEL
ACSSEL is an ACS robotic process. It is the ACS SSI Event Logger. It is modeled 
after the mini_el event logger provided by StorageTek, so its functional model 
differs slightly from other robotic test tools provided with Media Manager.

By default, ACSSEL listens on socket name (or IP port) 13740. If this entry is 
specified in vm.conf, you can change the default. This entry is read and 
interpreted where acsd is running, and the format for this entry is as follows:

ACS_SEL_SOCKET = socket_name

ACSSSI
ACSSSI is an ACS robotic process. By default, ACSSSI listens on unique, 
consecutive socket names starting as 13741. To specify socket names on an ACS 
library software host basic, add a configuration entry in vm.conf. This entry is 
read and interpreted on the host where acsd and acsssi are running, and the 
format for this entry is as follows:

ACS_SSI_SOCKET = ASC_library_software_host socket_name

Example ACS_SSI_SOCKET = Einstein 13750

Additional Media manager port information
The following sections describe known firewall problems that you might 
encounter when using NetBackup with certain other products.

ACS
Communication is required between the media server that has the ACS drives 
configured and the ACS server, but NetBackup has no control over the 
communication between these computers. The communication is handled via a 
RPC mechanism without a common port. Therefore, it is not possible to define 
the ports that would need to be open if there were a firewall between the media 
server and the ACS server.

TLH
Communication is required between the media server that has the robotic 
control and the server that has IBM's Library Manager. This communication is 
through an unknown network port, and NetBackup has no control over that port 
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number. Therefore, it is not possible to define the ports that would need to be 
open if there were a firewall between the media server and the IBM Library 
Manager server.

LMF
Communication is required between the media server that has the robotic 
control and Fujitsu's LMF server. This communication is through an unknown 
network port, and NetBackup has no control over that port number. Therefore, 
it is not possible to define the ports that would need to be open if there were a 
firewall between the media server and Fujitsu's LMF server.

TLM
Communication is required between the media server that has the robotic 
control and ADICs DAS/SDLC server. NetBackup has no control over the 
communication mechanism and does not know which ports are used between 
the media server and ADICs DAS/SDLC server. Therefore, it is not possible to 
define the ports that would need to be open if there were a firewall between the 
media server and ADICs DAS/SDLC server.
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 A
Configuring port usage 
without a GUI

“Configuration options” on page 23 shows how to configure settings and port 
usage by using the NetBackup GUI. In many cases, you can also edit a text file or 
use a command line to configure your system.

The following sections summarize how to configure port usage settings without 
a GUI. This appendix is not intended to provide details on using commands to 
change settings. For more information on any of these commands or files, see 
the following resources:

■ NetBackup Administrator’s Guide for UNIX and Linux, Volumes I and II

■ NetBackup Administrator’s Guide for Windows, Volumes I and II

■ NetBackup Media Manager Administrator’s Guide for UNIX

■ NetBackup Media Manager Administrator’s Guide for Windows

■ NetBackup Commands for UNIX and Linux

■ NetBackup Commands for Windows
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Port usage settings in NetBackup configuration - 
bp.conf

This section describes the NetBackup configuration settings related to port 
usage. All of the NetBackup configuration settings are described in NetBackup 
Administrator's Guide for UNIX and Linux, Volume II in the Additional 
Configuration/NetBackup Configuration Options section.

On UNIX or Linux systems, you can edit the 
/usr/openv/netbackup/bp.conf file directly to update several port usage 
settings for the local computers NetBackup configuration. Typically, you would 
use a text editor such as vi(1) to read and update the file.

You can also use the bpgetconfig and bpsetconfig commands from UNIX, 
Linux, or Windows NetBackup servers to read and update NetBackup 
configuration for local or remote computers. The bpgetconfig(1M) and 
bpsetconfig(1M) commands are described in the NetBackup Commands for 
UNIX and Linux and the NetBackup Commands for Windows manuals.

Typically, you would read the configuration with the bpgetconfig command 
and copy it into a temporary file, edit the configuration in the temporary file and 
then use the bpsetconfig command to update the configuration from the 
temporary file. 

Example You might issue the following commands to 
update the NetBackup configuration of the 
computer client1:

bpgetconfig -M client1 > conf.txt
vi conf.txt # if UNIX or Linux
notepad conf.txt # if Windows
bpsetconfig -h client1 conf.txt

Port usage related NetBackup configuration settings

ALLOW_NON_RESERVED_PORTS = YES | NO
Specifies if the NetBackup client daemon (bpcd) on the local computer can 
accept remote connections from non-reserved ports (port numbers 1024 or 
greater).

■ NO (default for NetBackup 5.1 and earlier) means that bpcd requires remote 
connections to come from reserved ports (port numbers less than 1024).

■ YES (default for NetBackup 6.0 and later) means that bpcd allows remote 
connections to come from non-reserved ports (port numbers less than 
1024).
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This option can be useful when NetBackup clients and servers are on opposite 
sides of a firewall.

You should specify YES for this setting if NetBackup servers are configured via 
the DEFAULT_CONNECT_OPTIONS or CONNECT_OPTIONS settings or bpclient 
command line to connect to the local computers bpcd with non-reserved source 
port numbers.

This setting can also be configured in the NetBackup Administration GUI by 
using the Host Properties > Universal Settings > Accept Connections on 
Non-reserved Ports checkbox.

RANDOM_PORT = YES | NO
Specifies whether NetBackup chooses source port numbers randomly or 
sequentially when it requires one for communication with NetBackup on other 
computers.

■ YES (the default) means that NetBackup chooses port numbers randomly 
from those that are free in the allowed range.

Example If the range is from 1024 through 5000, it 
chooses randomly from the numbers in this 
range.

■ NO means that NetBackup chooses numbers sequentially, starting with the 
highest number that is available in the allowed range.

Example If the range is from 1024 through 5000, 
NetBackup chooses 5000 (assuming it is free). 
If 5000 is being used, port 4999 is chosen.

The allowed port ranges are determined by the CLIENT_PORT_WINDOW and 
CLIENT_RESERVED_PORT_WINDOW settings.

This setting can also be configured in the NetBackup Administration GUI via the 
Host Properties > Port Ranges > Use random port assignments checkbox.

CLIENT_PORT_WINDOW = min max
Specifies the range of non-reserved source ports on this computer that are used 
for connecting to NetBackup on other computers. This setting applies to most 
NetBackup connection. The CLIENT_RESERVED_PORT_WINDOW setting applies 
when connecting to bpcd with the legacy bpcd destination port number with 
reserved source port numbers.

■ min is the minimum port number in the range. It should be 0 (zero) or a 
number between 1024 and 65535.

■ max is the maximum port number in the range. It should be a number 
between min and 65535.
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If min is 0 (zero), the operating system determines the source port number and 
max is ignored. The default is 0 0.

Example The following command permits ports from 4800 
through 5000:
CLIENT_PORT_WINDOW = 4800 5000

This setting can also be configured in the 
NetBackup Administration GUI via Host Properties > Port 
Ranges > Client port window.

CLIENT_RESERVED_PORT_WINDOW = min max
Specifies the range of reserved source ports on this computer that are used for 
connecting to bpcd on other computers. This setting is applicable when 
connecting to bpcd with the legacy bpcd destination port number with reserved 
source port numbers.

■ min is the minimum port number in the range. It should be 0 (zero) or a 
number between 1 and 1023.

■ max is the maximum port number in the range. It should be a number 
between min and 1023.

If min is 0 (zero), the operating system determines the source port number and 
max is ignored. The default is 512 1023.

Example The following command permits ports from 700 
through 980:

CLIENT_RESERVED_PORT_WINDOW = 700 980

This setting can also be configured in the 
NetBackup Administration GUI via Host Properties > Port 
Ranges > Client reserved port window.

SERVER_PORT_WINDOW = min max
Specifies the range of reserved destination ports on this computer that are used 
by bpcd on other computers when connecting back to this computer. This 
setting is applicable when connecting to bpcd with the legacy bpcd destination 
port number with non-reserved source port numbers with random port bpcd 
connect back.

■ min is the minimum port number in the range. It should be 0 (zero) or a 
number between 1024 and 65535.

■ max is the maximum port number in the range. It should be a number 
between min and 65535.
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If min is 0 (zero), the operating system determines the source port number and 
max is ignored. The default is 1025 5000.

Example The following command permits ports from 3000 
through 7500:

SERVER_PORT_WINDOW = 3000 7500

This setting can also be configured in the 
NetBackup Administration GUI via Host Properties > Port 
Ranges > Server port window.

SERVER_RESERVED_PORT_WINDOW = min max
Specifies the range of reserved destination ports on this computer that are used 
by bpcd on other computers when connecting back to this computer. This 
setting is applicable when connecting to bpcd with the legacy bpcd destination 
port number with reserved source port numbers with random port bpcd 
connect back.

■ min is the minimum port number in the range. Should be 0 (zero) or a 
number between 1 and 1023.

■ max is the maximum port number in the range. Should be a number 
between min and 1023.

If min is 0 (zero), the operating system determines the source port number and 
max is ignored. The default is 512 1023.

Example The following command permits ports from 700 
through 980:

SERVER_RESERVED_PORT_WINDOW = 700 980

This setting can also be configured in the 
NetBackup Administration GUI via Host Properties > Port 
Ranges > Server reserved port window.

CONNECT_OPTIONS = host 0|1|2 0|1|2 0|1|2|3 and 
DEFAULT_CONNECT_OPTIONS = 0|1 0|1 0|1|2
The CONNECT_OPTIONS and DEFAULT_CONNECT_OPTIONS configuration 
values determine how the local computer connects to services on other 
NetBackup systems. DEFAULT_CONNECT_OPTIONS is only available for 
NetBackup 6.0 and later. The values for CONNECT_OPTIONS are a host name 
followed by three digits. The values for DEFAULT_CONNECT_OPTIONS are three 
digits.
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■ host is a remote NetBackup system that the local computer connects to. You 
may have multiple CONNECT_OPTIONS entries in the configuration. If a 
host is not specified in any CONNECT_OPTIONS entries, the values from the 
DEFAULT_CONNECT_OPTIONS entry are used.

■ The first digit is the reserved versus non-reserved source port:

■ 0 means that connections to bpcd from the local computer should use a 
reserved source port number selected from the 
CLIENT_RESERVED_PORT_WINDOW range. (Default.)

■ 1 means that connections to bpcd from the local computer should use a 
non-reserved source port number selected from the 
CLIENT_PORT_WINDOW range. Be sure ALLOW_NON_RESERVED_PORTS 
= YES is set on the remote hosts that the local computer may connect 
to.

■ 2 when specified in CONNECT_OPTIONS means that the value from 
DEFAULT_CONNECT_OPTIONS should be used instead.

■ The second digit is bpcd call-back method:

■ 0 means that for connections to bpcd from the local computer, bpcd 
will connect back to a random port number on the local computer 
selected from the SERVER_RESERVED_PORT_WINDOW range or 
SERVER_PORT_WINDOW range on the server. (Default for 5.1 and 
earlier.)

■ 1 means that for connections to bpcd from the local computer, bpcd 
will connect back to the vnetd port number on the server. (Default for 
6.0 and later.)

■ 2 when specified in CONNECT_OPTIONS means that the value from 
DEFAULT_CONNECT_OPTIONS should be used instead.

■ The third digit is the legacy versus vnetd destination port:

■ 0 means that the local computer will first attempt to connect to a 
NetBackup service using the vnetd destination port number. If that 
fails, the local computer will attempt to connect to the NetBackup 
service using the legacy destination port number for that service. 
(Default for 6.0 and later.)

■ 1 means that connections to a NetBackup service from the local 
computer use the vnetd destination port number.

■ 2 means that connections to a NetBackup service from the local 
computer use the legacy destination port number for the service.

■ 3 when specified in CONNECT_OPTIONS means that the value from 
DEFAULT_CONNECT_OPTIONS should be used instead.
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Note: vnetd can only be used as the destination port if the remote host is 
NetBackup 6.0 or later and is not a NetWare client.

If vnetd is used as the destination port, the settings from the first two digits are 
not applicable. In that case, the source port will be from the non-reserved 
CLIENT_PORT_WINDOW range and no connect back will be used.

Example The connection options to most remote hosts 
from the local computer will use the 
NetBackup 5.1 defaults.  However, connections 
to host servers will use theNetBackup 6.0 
defaults:

CONNECT_OPTIONS = servers 0 1 0
DEFAULT_CONNECT_OPTIONS = 0 0 2

Example The DEFAULT_CONNECT_OPTIONS is restored to 
the defaults for NetBackup 6.0 and later:

DEFAULT_CONNECT_OPTIONS = 0 1 0

These settings can also be configured in the 
NetBackup Administration GUI via the Host Properties 
> Firewall panel.

Configuring port usage client attribute settings - 
bpclient

The bpclient command is used to update a variety of client attributes in a 
database on the NetBackup master server.

The bpclient (1M) command is described in the NetBackup Commands for 
UNIX and Linux and the NetBackup Commands for Windows manuals.

The -connect_options argument to bpclient sets three port usage attributes 
that NetBackup servers use when connecting to bpcd on the specified 
NetBackup client. To specify connection options to a client, first make sure the 
client is in the master servers database:

bpclient -client name -add

where name is the name of the client.
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bpclient -client name -update -connect_options 0|1|2 0|1|2 0|1|2|3
This is the format of the bpclient command to update client connection 
attributes. The -connect_options argument is followed by three digits.

■ The first digit is the reserved versus non-reserved source port:

■ 0 means that connections to bpcd from servers to the specified client 
should use a reserved source port number selected from the 
CLIENT_RESERVED_PORT_WINDOW range on the server. (Default for 
5.1 and earlier servers.)

■ 1 means that connections to bpcd from servers to the specified client 
should use a non-reserved source port number selected from the 
CLIENT_PORT_WINDOW range on the server. Be sure 
ALLOW_NON_RESERVED_PORTS = YES is set on the client.

■ 2 means that the reserved versus non-reserved source port setting is 
determined by the CONNECT_OPTIONS and 
DEFAULT_CONNECT_OPTIONS on the server. (Default for 6.0 and later 
servers.)

■ The second digit is BPCD call-back method:

■ 0 means that for connections to bpcd from servers to the specified 
client, the client will connect back to a random port number of the 
server selected from the SERVER_RESERVED_PORT_WINDOW range or 
SERVER_PORT_WINDOW range on the server. (Default for 5.1 and earlier 
servers.)

■ 1 means that for connections to bpcd from servers to the specified 
client, the client will connect back to the vnetd port number on the 
server.

■ 2 means that the random port versus vnetd port setting is determined 
by the CONNECT_OPTIONS and DEFAULT_CONNECT_OPTIONS on the 
server. (Default for 6.0 and later servers.)

■ The third digit is the legacy bpcd versus vnetd destination port:

■ 0 means that servers will first attempt to connect to bpcd on the 
specified client using the vnetd destination port number. If that fails, 
servers will attempt to connect to bpcd on the specified client using 
the legacy bpcd destination port number.

■ 1 means that connections to bpcd from servers to the specified client 
use the vnetd destination port number.

■ 2 means that connections to bpcd from servers to the specified client 
use the legacy bpcd destination port number. (Default for 5.1 and 
earlier servers.)
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■ 3 means that the legacy bpcd versus vnetd destination port setting is 
determined by the CONNECT_OPTIONS and 
DEFAULT_CONNECT_OPTIONS on the server. (Default for 6.0 and later 
servers.)

Note: vnetd can only be used as the destination port if the client is NetBackup 
6.0 or later and is not a NetWare client.

If vnetd is used as the destination port, the settings from the first two digits are 
not applicable. In that case, the source port will be from the non-reserved 
CLIENT_PORT_WINDOW range and no connect back will be used.

Example The following commands will set the legacy 
(pre NetBackup 6.0) client connect options 
for connections to client client1.  You might 
find this useful for older clients:

bpclient -add -client client1
bpclient -update -client client1 
-connect_options 0 0 2

Example The following command restores the NetBackup 
6.0 client connect option defaults.  You 
might find this useful after you upgrade the 
client to 6.0:

bpclient -update -client client1 
-connect_options 2 2 3

These settings can also be configured in the 
NetBackup Administration GUI via the Host Properties 
> Client Attributes > Connect Options tab.

Port usage settings in Media Manager configuration - vm.conf
For Media Manager, update port usage settings by editing the 
/usr/openv/volmgr/vm.conf file (UNIX or Linux) or the 
install_path\volmgr\vm.conf file (Windows). There is no GUI to use 
when changing these settings.

RANDOM_PORTS = YES | NO
The RANDOM_PORTS setting specifies how Media Manager chooses a source port 
to use when the Media Manager software on one computer needs to 
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communicate with the Media Manager software on another computer. The 
default is YES.

■ YES means that source port number is selected randomly from the range 
defined by the CLIENT_PORT_WINDOW setting.

■ NO means that source port number is selected sequentially randomly from 
the range defined by the CLIENT_PORT_WINDOW setting. The media 
manager will attempt the connection with the highest source port number 
in the range. If that source port does not work, the media manager will try 
the next highest source port number in the list until it finds a source port 
number that works.

CLIENT_PORT_WINDOW = min max
Where min and max are integers from 1024 to 65535 or 0 (zero). These values 
define the range of source ports used on out-going media manager connections. 
min defines the lowest source port number and max defines the highest source 
port number. If min is 0 or if max is less than min, then the media manager will 
let the operating system determine the source port number. The default is 0 0. 

Example This setting will define a source port range 
of 3000 to 8000:
CLIENT_PORT_WINDOW = 3000 8000

CONNECT_OPTIONS = host 0 0 0|1|2
The CONNECT_OPTIONS setting specifies the destination port number to be used 
to connect to media manager services. You can specify multiple 
CONNECT_OPTIONS settings in the vm.conf file.

■ host is the host name of a computer with media manager services such as 
vmd, tshd, and tldcd.

■ The first two digits are ignored.

■ The third digit is the legacy media manager ports versus vnetd destination 
port:

■ 0 means that the local computer will first attempt to connect to the 
media manager service on the specified host using the vnetd 
destination port number. If that fails, servers will attempt to connect to 
the media manager service on the specified host using the legacy media 
manager destination port number.

■ 1 means that connections to the media manager service on from the 
local computer to the specified host use the vnetd destination port 
number.
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■ 2 means that connections to the media manager service on from the 
local computer to the specified host use the legacy media manager 
destination port number. (Default for 5.1 and earlier servers.)

For NetBackup 6.0 and later, if no CONNECT_OPTIONS settings are specified in 
the vm.conf file, the media manager will default to the 
DEFAULT_CONNECT_OPTIONS and CONNECT_OPTIONS settings defined in 
the NetBackup configuration.

Example This setting forces media manager connections 
to server3 to use vnetd as the destination 
port:
CONNECT_OPTIONS = server3 0 0 1
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